1 Overview

This document gives step-by-step instructions for simulating turbulent flow from an array of jets that impinge on a flat surface. The physical problem is a nearly exact replica of heat transfer experiments performed by Garimella and Schroeder [1]. This cookbook is only concerned with setting up and solving the flow field. A subsequent cookbook deals the solution to the energy equation ($T$ field). The heat transfer simulation will allow direct comparison with the results of Garimella and Schroeder.

To set up and solve this model with STAR-CD, the following new features are introduced.

1. Multiblock mesh generation
2. Coupling of meshes generated with different coordinate systems
3. Use of the $k – \epsilon$ turbulence model

1.1 Physical Problem

Figure 1 is a schematic of the jet impingement apparatus. Air enters the plenum at the top of the device and exits through an array of round nozzles. Garimella and Schroeder studied two different types of jet arrays: one with four jets, and one with nine jets. Figure 2 shows the relative positions of the jets in the four-jet array. After the air leaves the nozzles, it impinges on the heated surface and then exhausts through the side of the device.

Figure 3 shows a section through two of the nozzles in the four-jet array. The geometrical parameters used in this cookbook are

$$S = 12 \text{ mm,}\quad d = 3.18 \text{ mm,}\quad W = 40 \text{ mm,}\quad H = 12 \text{ mm}$$

The jet Reynolds number is

$$Re = \frac{\rho V_j d}{\mu}$$

(Figure 1. Schematic of apparatus used by Garimella and Schroeder [1].)
where $\rho$ and $\mu$ are the density and viscosity of air in the jet, $V_j$ is the average velocity of the air in the jet, and $d$ is jet diameter. Garimella and Schroeder present results for jet Reynolds numbers between 5,000 and 20,000. At these large Reynolds numbers, the jets will be fully turbulent.

To simulate the flow with STAR-CD we need to define the geometry of the fluid domain, and prescribe appropriate boundary conditions. The plenum area is large compared to the jet area ($h_p \gg d$), so the average (downward) velocity in the plenum $V_p$ will be small compared to the average jet velocity $V_j$. Furthermore, there is no need to simulate the entire plenum flow as long as velocity field just upstream of the nozzles is properly resolved. Thus, it is reasonable impose a uniform velocity $V_p$ at the top of the plenum space.

The (average) plenum velocity is related to the (average) jet velocity by the incompressible mass conservation equation

$$V_p A_p = nV_j A_j$$

where $A_p$ is the cross-section area of the plenum, $A_j$ is the area of one jet, and $n$ is the total number of jets. Combining Equation (1) and Equation (2) gives

$$V_p = \frac{n\mu A_j}{\rho d A_p} Re$$

Table 1 shows values of $V_p$ and $V_j$ for the Reynolds numbers obtained by Garimella and Schroeder. The last column of Table 1 is the measured pressure difference between the plenum and the ambient. The pressure data will provide a rough check on the CFD simulation results.
Table 1: Plenum velocity, jet velocity, and measured plenum pressure differential for the four-jet array experiments of Garimella and Schroeder.

<table>
<thead>
<tr>
<th>Re</th>
<th>$V_p$ (m/s)</th>
<th>$V_j$ (m/s)</th>
<th>$\Delta p$ (Pa)</th>
</tr>
</thead>
<tbody>
<tr>
<td>5000</td>
<td>0.6114</td>
<td>15.397</td>
<td>486</td>
</tr>
<tr>
<td>8250</td>
<td>1.0089</td>
<td>25.405</td>
<td>1250</td>
</tr>
<tr>
<td>10000</td>
<td>1.2229</td>
<td>30.794</td>
<td>1818</td>
</tr>
<tr>
<td>15000</td>
<td>1.8343</td>
<td>46.191</td>
<td>3861</td>
</tr>
<tr>
<td>20000</td>
<td>2.4457</td>
<td>61.588</td>
<td>6636</td>
</tr>
</tbody>
</table>

2 Preparing and Launching PROSTAR

This model introduces cell couples as a device for connecting adjacent meshes. The size of the couple sets in this model is larger than the default value assumed by PROSTAR. As part of the set-up, we will need to run the Prosize application to increase the memory reserved for the couple sets.

1. Create a directory to hold the files for this session. To keep network traffic to a minimum (especially with large models), work in a temporary directory of the local machine. For example: C:\temp\yourname\jets.

   Remember to copy your results back to a private directory after completing an analysis!

2. Tell STAR-CD where to find the working directory.

   File → Set Working Directory . . .

   Navigate to the temporary working directory and click OK

3. Run the STAR-CD Launcher

4. Start Prosize

   a. Click Continue after reading the message in the Prosize Info window.
   b. Click Modify in response the query about what to do with your existing param.prp file
   c. Click OK when Prosize says that the param.prp has been saved in your working directory.
   d. Click on the Matches tab of the Prosize Data Entry window.
   e. Enter 500 (?) in the NCPDIM box (Maximum number of Cells in each Couple).
   f. Click Save
   g. Click OK when Prosize says that the param.prp has been saved in your working directory.
   h. Click Exit.

5. Start PROSTAR

6. In the opening screen, enter a meaningful case name, e.g., jetImpingement
3 CREATE THE MESH

7. Uncheck the boxes for **Resume from Existing .mdl File?** and **Append to Previous .echo File?**

8. Click **Continue**

9. Name the model file.
   - From the menu bar of the PROSTAR window: **File → Model Title**
   - Enter a descriptive title such as “Impingement of an array of four confined jets”
   - Click **Apply**

3 Create the Mesh

The mesh for this problem consists of three mesh zones joined together by *arbitrary couples*. An arbitrary couple is a STAR-CD device for providing continuity between mesh blocks when the vertices of cells sharing a common face do not coincide (See [2, pp. 4-2—4-26]). The flow domain consists of a brick-shaped block for the plenum, a cylindrical “block” for the nozzle, and another brick-shaped block for the space between the nozzle plate and the heated surface.

To simplify the model, we exploit the symmetry of the apparatus. Only the upper right quadrant of Figure 2 will be modeled. Note that this does not affect the calculation of $V_p$ in Equation (3) or the results in Table 1. For the quarter model, both the $A_p$ and $A_j$ are reduced by a factor of four, and the ratio $A_j/A_p$ remains constant.

3.1 Prepare Cell Types

Mesh creation and manipulation in this model can be managed more easily if we define different cell types for each of the three main regions in the domain. STAR-CD’s cell table feature is used to manage different material types. Here, we use only one type of material – the fluid, air – but we define cells with different colors and group names. The colors and group names will help us select cells in different regions after the mesh has been created.

Open the **Color Tool** to inspect the available colors. From the menubar of the PROSTAR Display Window, select

**Tools → Color Tool...**

In the upper right hand quadrant of the window, click on a few of the colored boxes numbered 1 through 20. As you click on a box, the corresponding color is shown in the larger **Color Index** box in the left half of the window. We will use the following color scheme.

<table>
<thead>
<tr>
<th>Color Index</th>
<th>Color</th>
<th>Fluid Region</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>red</td>
<td>Impingement zone between the nozzle plate and the heated surface</td>
</tr>
<tr>
<td>7</td>
<td>yellow</td>
<td>Nozzle zone – cylindrical fluid volume inside the nozzle plate.</td>
</tr>
<tr>
<td>5</td>
<td>cyan</td>
<td>Plenum zone – fluid upstream of the nozzle plate.</td>
</tr>
</tbody>
</table>

Other color schemes are equally useful so long as the colors for different regions are clearly distinguishable on the screen.

After you have become familiar with the color naming conventions, close the **Color Tool** and open the **Cell Tool**. From the menubar of the PROSTAR Display Window, select
Tools → Cell Tool...

Create three new entries in the Cell Table

1. Click Edit Types... (the yellow button below the cell table)

2. Click the first empty row in the list of Cell types in the left half of the window.

3. Set the following values in the boxes on the right half of the window (skip over entries not listed below)

<table>
<thead>
<tr>
<th>Field Label</th>
<th>You Enter/Select</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell type</td>
<td>Fluid</td>
<td>pop-up menu</td>
</tr>
<tr>
<td>Material number</td>
<td>1</td>
<td>All cells will have this material type (fluid)</td>
</tr>
<tr>
<td>Color Table Index</td>
<td>2</td>
<td>other indices will be 7 and 5</td>
</tr>
<tr>
<td>Group Number</td>
<td>1</td>
<td>other groups will be 2 and 3</td>
</tr>
<tr>
<td>Name</td>
<td>ImpingementCells</td>
<td>No spaces are allowed in the name of the cell type.</td>
</tr>
</tbody>
</table>

4. Click Apply

5. Click the next empty row in the list of Cell types in the left half of the window.

6. Set the following values in the boxes on the right half

<table>
<thead>
<tr>
<th>Field Label</th>
<th>You Enter/Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell type</td>
<td>Fluid</td>
</tr>
<tr>
<td>Material number</td>
<td>1</td>
</tr>
<tr>
<td>Color Table Index</td>
<td>7</td>
</tr>
<tr>
<td>Group Number</td>
<td>2</td>
</tr>
<tr>
<td>Name</td>
<td>NozzleCells</td>
</tr>
</tbody>
</table>

7. Click Apply

8. Click the next empty row in the list of Cell types in the left half of the window.

9. Set the following values in the boxes on the right half

<table>
<thead>
<tr>
<th>Field Label</th>
<th>You Enter/Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell type</td>
<td>Fluid</td>
</tr>
<tr>
<td>Material number</td>
<td>1</td>
</tr>
<tr>
<td>Color Table Index</td>
<td>5</td>
</tr>
<tr>
<td>Group Number</td>
<td>3</td>
</tr>
<tr>
<td>Name</td>
<td>PlenumCells</td>
</tr>
</tbody>
</table>

10. Click Apply

Note that the cell types could have been defined on the fly when the mesh in each zone is created.
3.2 Mesh Block Generation

Now that the cell types are defined, we are ready to begin mesh generation. Figure 4 depicts the three mesh zones that constitute the fluid domain. The bottom brick-shaped region — called the impingement zone — is the fluid between the heated surface and the nozzle plate. The middle region is the fluid inside the nozzle — the nozzle zone — is a short cylinder of fluid. The third region is the plenum space — the plenum zone — is a brick shaped region above the nozzle. Each of these zones is defined with its own local coordinate system. The coordinate system (and its origin) of the impingement zone is coincident with the global coordinate system for the model. The nozzle zone and the plenum zone are defined with local coordinate systems that are offset from the global coordinate system by the distances listed in the following table.

<table>
<thead>
<tr>
<th>Zone</th>
<th>Coordinate System</th>
<th>$X_c$</th>
<th>$Y_c$</th>
<th>$Z_c$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impingement</td>
<td>Cartesian</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Nozzle</td>
<td>Cylindrical</td>
<td>6</td>
<td>6</td>
<td>12</td>
</tr>
<tr>
<td>Plenum</td>
<td>Cartesian</td>
<td>0</td>
<td>0</td>
<td>15.18</td>
</tr>
</tbody>
</table>

Detailed Steps

1. Generate the block between the heated surface and the nozzle plate
   a. Open the Create 3-D Grids using Simple Shapes panel of the Star GUIde NavCenter. 
      
      Create and Import Geometry  
      → Create Grids
      → Create 3-D Grids using Simple Shapes
 
   b. Click Select a Coordinate System
      i. Select coordinate system 2 Cartesian  
      ii. Click Set Active  
      iii. Click Close
 
   c. Click Select Cell Type
      i. In the Cell Table Editor select cell type number 4 (“ImpingementCells”)  
      ii. Click Apply  
      iii. Close the Cell Table Editor
d. In the *Extent of Domain* region at the right side of the NavCenter window, enter the following values in the boxes:

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Maximum</th>
<th>Number of Cells</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>0</td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>Y</td>
<td>0</td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>Z</td>
<td>0</td>
<td>12</td>
<td>12</td>
</tr>
</tbody>
</table>

Note that the dimensions are in millimeters. The scale factor for the geometry will be set when the .geom file is written.

e. Click *Generate Mesh* at the bottom of the right side of the NavCenter window.

2. Generate the cylindrical air space inside the nozzle plate.

a. Return to the *Extent of Domain* panel in the Star GUIde NavCenter.

b. Click *Select a Coordinate System*

i. Select the first empty number in the coordinate system list (coordinate system number 4).

ii. At the bottom of the window, select *Cylindrical* from the pop-up menu.

iii. In the first three boxes next to *Cylindrical* at the bottom of the window, enter the 

   \( x, y, z \) offsets of the new coordinate system

   \[
   \begin{align*}
   \text{Cylindrical} & \quad 6 & \quad 6 & \quad 12 & \quad \_ & \quad \_ & \quad \_ & \quad \_ \\
   \end{align*}
   \]

iv. Click *New Global*

   *Note: Clicking *New Global* does not create a new global origin. Rather, it creates a new local system having its origin offset by the designated amounts. Those offsets are measured from the *global* origin. If instead *New Local* was selected, the offsets would be measured from the current local coordinate system.*

v. Click *Set Active*

vi. Click *Close*

c. Click *Select Cell Type*

i. In the *Cell Table Editor* select cell type number 5 ("NozzleCells")

ii. Click *Apply*

iii. *Close* the Cell Table Editor

d. In the *Extent of Domain* region at the right side of the NavCenter window, enter the following values in the boxes:

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Maximum</th>
<th>Number of Cells</th>
</tr>
</thead>
<tbody>
<tr>
<td>( R )</td>
<td>0</td>
<td>1.509</td>
<td>5</td>
</tr>
<tr>
<td>( \theta )</td>
<td>0</td>
<td>360</td>
<td>20</td>
</tr>
<tr>
<td>( Z )</td>
<td>0</td>
<td>3.18</td>
<td>10</td>
</tr>
</tbody>
</table>

e. Click *Generate Mesh* at the bottom of the right side of the NavCenter window.

f. The cells in the cylindrical nozzle zone have an interior surface (a crack) that needs to be eliminated before proceeding. This surface is an internal boundary corresponding to the interface between the \( \theta = 0 \) plane and the \( \theta = 360 \) plane.

i. To see the crack surface, create a cell set that consists only of the cells inside the nozzle. First orient the model in the PROSTAR Display Window so that some of the (yellow) cells in the nozzle zone are visible. With the nozzle cells visible, create a cell set by color:
Figure 5: Crack in cylindrical mesh inside the nozzle.

Click on any (yellow) cell in the nozzle zone.

ii. Click the `Cell Plot` box.

iii. Switch the rendering to `Quick Hidden Line`. After zooming in on the visible part of the mesh, the result should be something like that in Figure 5.

To fix the crack, merge the vertices common to the $\theta = 0$ and $\theta = 360$ planes.

i. Create a vertex set from all vertices in the cylindrical nozzle zone. Make sure only the cells from the nozzle zone are visible (See selection of the cell set in step 2(f)i, above). Zoom out so that all cells in the nozzle zone are visible. Begin selection of the vertex set with

`V-> New -> Zone ...`

Using the cursor, draw a box around the cylindrical mesh zone. Click `Done` when the box surrounds the zone.

ii. Open the `Assemble Grids` panel in the Star GUIde NavCenter

`Create and Import Grids -> Assemble Grids`

iii. Select the `Vertex Merge` tab

iv. Select `Current Vertex Set`

v. Select `Keep: Low`

vi. Increase the tolerance to 0.01

vii. Click `Merge`

viii. View the results of the merge in the output of the command window.

h. Verify that the merge operation worked by performing a grid check

i. Select the `Check Grid` panel from the Star GUIde NavCenter
Check and Fix Grid → Check Grid

ii. Select Check Option: Cracks
iii. Click Apply
iv. View the results of the check in the command window.

i. After completion of the merge operation, return the cell plot to view all cells in the fluid domain

Then click (Cell Plot)

3. Generate the mesh block in the plenum

a. Return to the Extent of Domain panel in the Star GUIde NavCenter.
b. Click Select a Coordinate System
   i. Select the first empty number in the coordinate system list
   ii. At the bottom of the window, select Cartesian from the pop-up menu
   iii. In the first three boxes next to Cartesian at the bottom of the window, enter the $x$, $y$, $z$ offsets of the new coordinate system
   iv. Click New Global
   v. Click Set Active
   vi. Click Close
c. Click Select Cell Type
   i. In the Cell Table Editor select cell type number 6 ("PlenumCells")
   ii. Click Apply
   iii. Close the Cell Table Editor
d. In the Extent of Domain region at the right side of the NavCenter window, enter the following values in the boxes

<table>
<thead>
<tr>
<th>Minimum</th>
<th>Maximum</th>
<th>Number of Cells</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>0</td>
<td>20</td>
</tr>
<tr>
<td>Y</td>
<td>0</td>
<td>20</td>
</tr>
<tr>
<td>Z</td>
<td>0</td>
<td>16</td>
</tr>
</tbody>
</table>
e. Click Generate Mesh at the bottom of the right side of the NavCenter window

4. Inspect the mesh

a. Change the model view in the PROSTAR Display Window

View $\rightarrow$ Isometric $\rightarrow$ -1,-1,1

Free rotate the model so that the cylindrical nozzle zone is visible. Figure 6 shows the completed mesh.
b. Click Show edges icon along the left the PROSTAR Display window. The result should look like Figure 7.
c. Use the mouse to rotate the model and inspect the mesh. Notice that the three zones of cells are separated by edges. The vertices along the coincident faces do not align, so the mesh zones cannot be connected by merging vertices. Instead, we connect these mesh zones with arbitrary couples.
Figure 6: Mesh for the quarter-model.

Figure 7: Edges of mesh zones for the quarter-model.
3.3 Mesh Couple Creation

Couples are used to join regions in the mesh where surfaces coincide, but the cell vertices in the adjoining regions do not coincide. Refer to Chapter Four in the STAR-CD User Guide for information on creating mesh couples. When couples are used to join meshes, any coincident vertices are not merged.

There are two types of couples in STAR-CD: integral couples and arbitrary couples. We use arbitrary couples in this cookbook. An arbitrary couple creates a connection between a master cell and slave cells. The slave cells are usually smaller so that one or more slave cells are connected to a single master cell. To achieve this kind of connectivity in the jet impingement model, the slave cells will be located in the nozzle zone, which has a finer mesh than either the impingement zone or the plenum zone. Figure 8 shows the relative sizes of the cells in the vicinity of the nozzle. Notice that the vertices of cells in the cylindrical nozzle zone do not align with vertices of cells in the impingement zone or the plenum zone.

Detailed Steps

1. Open the Couple Tool in the PROSTAR Display Window

2. Create new entries in the Couple Table
   a. Click Edit Types... (the yellow button immediately under the Couple Table list). This opens the Couple Table Editor window.
   b. In the Couple Table Editor
      i. Select the first empty line in the Couple List on the left half of the window.
      ii. Set the following values in the boxes on the right half of the window

<table>
<thead>
<tr>
<th>Field Label</th>
<th>You Enter/Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Couple Type</td>
<td>Arbitrary</td>
</tr>
<tr>
<td>Group Number</td>
<td>1</td>
</tr>
<tr>
<td>Master color</td>
<td>8</td>
</tr>
<tr>
<td>Slave color</td>
<td>10</td>
</tr>
<tr>
<td>Overlap Color</td>
<td>13</td>
</tr>
<tr>
<td>Partial Boundaries</td>
<td>On</td>
</tr>
<tr>
<td>Name</td>
<td>impingeToNozzle</td>
</tr>
</tbody>
</table>
Click Apply

iii. Select the next empty line in the Couple List on the left half of the window.

iv. Set the following values in the boxes on the right half of the window (note that only the Group Number and Name are different)

<table>
<thead>
<tr>
<th>Field Label</th>
<th>You Enter/Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Couple Type</td>
<td>Arbitrary</td>
</tr>
<tr>
<td>Group Number</td>
<td>2</td>
</tr>
<tr>
<td>Master color</td>
<td>8</td>
</tr>
<tr>
<td>Slave color</td>
<td>10</td>
</tr>
<tr>
<td>Overlap Color</td>
<td>13</td>
</tr>
<tr>
<td>Partial Boundaries</td>
<td>On</td>
</tr>
<tr>
<td>Name</td>
<td>plenumToNozzle</td>
</tr>
</tbody>
</table>

Click Apply

c. Close the Couple Table Editor window. The two new couple types should appear in the Couple Table list.

3. Create the couple between the impingement zone and the nozzle zone. The impingement zone has larger cell sizes, so it should be chosen as the master cells. The cells from the nozzle will be slave cells.

a. Prepare for the cell selection by zooming in on the nozzle cells to get a view similar to that in Figure 8.

b. In the Couple Tool window, select the third couple type from the list, and click Set Active Type (second yellow button).

c. Click Arbitrary Match... (the last red button).

i. Verify that the Couple type is 3 (last box) which was crate in the preceding step. If not, change it manually to 3.

ii. Note both the Master Cell Type/Group and Slave Cell Type/Group are set to cxt. This enables selection of the master and slave cell types with the mouse. Alternatively, you could change the Selection Option to Group Number and enter the cell group directly directly in these boxes. The cell group numbers were defined when the cell types were created (see Cell Tool in the PROSTAR Display Window).

iii. With cxt in the Master and Slave Type value boxes, click Apply. In response to clicking Apply, the cursor becomes active as a selection tool in the PROSTAR Display window.

A. Carefully select a cell in impingement zone (red cells). When you click on it, an “X” should appear on the cell face.

B. Carefully select a cell in the nozzle zone (yellow cells). When you click on it, an “X” should appear on the cell face.

iv. Verify that the couple was created.

A. In the Couple Tool Window:

Other → Couple Display → Slaves Last

This will create a display with the slave cells drawn on top of the master cells.

B. Open the Couple List from the menubar in the PROSTAR Display Window

Lists → Couples...
C. Click either the *Show Couples with Cells in Cset only* button or the *Show All Couples* button. The scrolling list in the left half of the window shows the master cells for the couple. Selecting any master cell causes its slave cells to be displayed in the list in the right half of the window.

D. Close the *Couple List* window

E. Turn off the display of the couple. In the *Couple Tool* window:

\[
\text{Other} \rightarrow \text{Couple Display} \rightarrow \text{Off}
\]

4. Create the couple between the plenum zone and the nozzle zone. This follows the preceding steps for the couple between the impingement zone and the nozzle zone. The key difference is that the Master cells are chosen from the plenum cell group.

a. Prepare for the cell selection by zooming in on the nozzle cells to get a view similar to that in Figure 8.

b. In the *Couple Tool* window, select the fourth couple type from the list, and click *Set Active Type* (second yellow button).

c. Click *Arbitrary Match...* (the last red button).

i. Verify that the *Couple type* is 5 (last box). If not, change it manually to 5.

ii. Note both the *Master Cell Type/Group* and *Slave Cell Type/Group* are set to *cxt*, which enables selection of the master and slave cell types with the mouse.

iii. With *cxt* in the Master and Slave Type value boxes, click *Apply*. In response to clicking *Apply* the cursor becomes active as a selection tool in the PROSTAR Display window.

A. Carefully select a cell in the **plenum zone** (cyan cells). When you click on it, an “X” should appear on the cell face.

B. Carefully select a cell in the **nozzle zone** (yellow cells). When you click on it, an “X” should appear on the cell face.

iv. Verify that the couple was created.

A. In the *Couple Tool Window*:

\[
\text{Other} \rightarrow \text{Couple Display} \rightarrow \text{Slaves Last}
\]

This will create a display with the slave cells drawn on top of the master cells.

B. Open the *Couple List* from the menubar in the PROSTAR Display Window

\[
\text{Lists} \rightarrow \text{Couples}...
\]

C. Click either the *Show Couples with Cells in Cset only* button or the *Show All Couples* button. The scrolling list in the left half of the window show the master cells for the couple. Selecting any master cell causes its slave cells to be displayed in the list in the right half of the window.

D. Close the *Couple List* window

E. Turn off the display of the couple. In the *Couple Tool* window:

\[
\text{Other} \rightarrow \text{Couple Display} \rightarrow \text{Off}
\]

### 3.4 Save the Model

File → Save Model

\[
\text{Remember to copy your *.mdl file back to a private directory before logging off your workstation!}
\]
4 Assign Material Properties

1. Verify that the fluid is air at standard conditions for this model. Open the panel for specifying the molecular properties of air in the Star GUIde NavCenter:

```
Thermophysical Models and Properties
    → Liquids and Gases
    → Molecular Properties
```

2. Turn on the $k - \epsilon$ turbulence model:

```
Thermophysical Models and Properties
    → Liquids and Gases
    → Turbulence Models
```

   a. Click On. This opens up the turbulence model specification panel.
   b. Select the Turbulence panel
   c. Select $K-E/High Reynolds Number$ from the pop-up menu for the Turbulence Model
   d. Click Apply

3. Verify that thermal modeling and buoyancy are turned off:

```
Thermophysical Models and Properties
    → Liquids and Gases
    → Thermal Models
    → Liquids and Gases
    → Buoyancy and Body Forces
```

4. Change the location of the monitoring cells. Prepare for this by creating a cell set that exposes fluid in the center of the nozzle.

```
Thermophysical Models and Properties
    → Liquids and Gases
    → Monitoring and Reference Data
```

   a. Prepare for the selection by defining a cell set that exposes the internal cells of the model.
      i. Orient the model in the PROSTAR Display Window so that you view it in the $(x, z)$ or $(y, z)$ planes.
      ii. Create a cell set with a zone that cuts through the cells in the nozzle.
   b. Return to the Monitoring and Reference Data panel in the Star GUIde NavCenter.
   c. To the right of the text box labelled Monitoring cell number click on the button that looks like a computer mouse. This activates the cross-hairs in the PROSTAR GUI. Click on a cell in the interior of the impingement zone that is downstream of the jet.
   d. Click Apply
   e. Reset the active cell set to all cells in the model.

4.1 Save the Model

In the menus for the PROSTAR Display window:

```
File → Save Model
```
5 Locate Boundary Regions

Use the Create Boundaries panel in the Star GUIde NavCenter to create the following boundary regions:

- Inlet at the top of the plenum
- Symmetry planes along \( x = 0 \) and \( y = 0 \). There are a total of four symmetry planes.
- Outlets on \( x = 30 \) and \( y = 30 \) planes of the impingement zone.

Note, the two outlets can be defined as a single outlet. After selecting cells for one outlet, simply add the other cells with another selection. Similarly, the two symmetry surfaces at \( x = 0 \) can be joined, and the two symmetry surfaces at \( y = 0 \) can be joined.

6 Assign Values to Boundary Conditions

1. Open the Define Boundary Regions panel in the Star GUIde NavCenter

   Define Boundary Conditions \( \rightarrow \) Define Boundary Regions

2. Select the Inlet boundary from the list of boundary regions.
   a. Set \( U = 0, V = 0, W = -1.2229 \)
   b. In the pop-up menu for Turb. Switch, select TE/Length. In response to the pop-up window, click Yes to the question about changing to Turbulence Intensity and mixing length for all boundary conditions.
   c. Enter 0.02 for the Turb. Intensity and 0.001 for Length.

   The turbulence intensity is the ratio of the magnitude of the turbulence fluctuations to the local mean velocity. A turbulence intensity of 0.02 means that \( w'/W = 0.02 \) at the inlet of the plenum. Since the high Reynolds number \( k-\epsilon \) model assumes the turbulence is isotropic, the specification of turbulence intensity also implies that \( u'/W = v'/W = 0.02 \). If the mean inlet velocity had non-zero components in the \( x \) and \( y \) directions, then the turbulence intensity specification would imply \( u'/\sqrt{U^2 + V^2 + W^2} = 0.02 \). A turbulence intensity of 0.02 is typical of a relatively quiescent flow.

   The Length of 0.001 means that the turbulence is characterized by a dissipation length scale of 1 mm. This small length is consistent with screens or other flow dampening structures in the inlet of the plenum.

   For the problem under consideration the inlet turbulence intensity will not have a big impact on the flow because high levels of turbulence are generated by the strong shear field in and downstream of the nozzle. Refer to Inlet Conditions in Chapter 6 of the STAR-CD Methodology Manual [?].

   d. Click Apply

3. Select one of the outlet boundary surfaces. (Note: if only one outlet region was defined, then the flow split must be set to 1.0.)
   - Select the Standard Option
   - Set the Flow Split to 0.5.
4. Select the other outlet boundary surfaces.
   - Select the Standard Option
   - Set the Flow Split to 0.5.
   - Click Apply

5. Check the boundary settings for the other symmetry surfaces. Accept the default values. Make sure the Standard Option is selected for each one.

6.1 Save the Model

In the menus for the PROSTAR Display window:

   File → Save Model
7 Set Solution and Output Controls

The default solution controls are appropriate. Verify the solution controls settings with the following steps.

1. Bring the Star GUIde window into focus by clicking on its title bar
2. Open the Solution Method panel:
   
   Analysis Controls → Solution Controls → Solution Method
3. Verify that the model will obtain a Steady State solution using the SIMPLE algorithm
4. Inspect the Equation Behavior panel
   
   Analysis Controls → Solution Controls → Solution Method → Equation Behavior
5. Verify that $U$, $V$, and $W$ velocity components, the pressure $P$, and the turbulence variables $k$ and $\epsilon$, are selected for solution.
6. If any changes are made, click Apply

The Star flow solver will run until the solution converges, or the maximum number of iterations are reached. If a model has not converged after the maximum number of iterations, restart the solution. The choice of maximum number of iterations is a matter of convenience.

1. Bring the Star GUIde window into focus by clicking on its title bar
2. Open the Run Time Controls panel:
   
   Analysis Preparation/Running → Set Run Time Controls
3. Enter 200 in the text box for Number of Iterations. This is not enough iterations to guarantee convergence (a little more than 400 total iterations are necessary), but it is sufficient for the flow solver to make good progress toward a solution. Restarting the solver will be necessary to attain the convergence tolerance.
4. Click Apply

8 Check the Model

It is a good idea to take advantage of built-in model checking features of STAR-CD

1. Bring the Star GUIde window into focus by clicking on its title bar
2. Open the Check Everything panel:
   
   Check Model Setup → Check Everything
3. Click the All button at the bottom of the panel.
4. Open the I/O window (underneath the PROSTAR Display Window) to view the results of the model checks. Verify that the model parameters are consistent with your boundary conditions, cell definitions, etc.

Note: If the cylindrical mesh was not properly merged, the mesh check will report Crack Errors. Return to step 2f on page 7 to fix these errors.
9 Save mdl and geom Files

The final stage of model preparation is to write the .geom and .prob files that are read by the Star flow solver.

1. Bring the PROSTAR Display window into focus by clicking on its title bar
2. In the menu bar of the PROSTAR Display window, select
   
   File $\rightarrow$ Write Geometry File

3. Inspect the file name and directory. The file name should have the same base name as the .mdl file you have been saving. The base name for the file is the case name in the dialog box that appears when PROSTAR is first launched. (reentrantInlet for this cookbook example)
4. Make any necessary changes and click Apply
5. Change the Scale Factor to 0.001. This is necessary because the model was built in PROSTAR using lengths in millimeters. The model solution in STAR is always in SI units, where the lengths are meters.
6. Notice that the File Type is set to Binary and the Option is set to Check. The binary file type is appropriate for models that are solved (with Star) on the same operating system as the graphical pre- and post-processor (PROSTAR). It is possible to have the solution run on a different computer, say a remote supercomputer.
7. Click Close
8. In the menu bar of the PROSTAR Display window, select
   
   File $\rightarrow$ Write Problem File

9. Click Apply
10. Click Close

9.1 Save the Model

In the menus for the PROSTAR Display window:

   File $\rightarrow$ Save Model

10 Solve with STAR

1. In the STAR-CD Launcher applet select Star
   
   Solve $\rightarrow$ Star

2. At the command window prompt, enter the case name, e.g. jetImpingement, and press the return key.
3. Open Star-Watch to monitor convergence.
11 Post-Processing

1. Inspect the solution history. Note that the model has not converged in 200 iterations. The model should be restarted. The convergence history after 411 iterations is shown in Figure 9. Note that the residual for the dissipation rate ($\epsilon$) has been reduced by four orders of magnitude. Thus, even though the $\epsilon$ residual is above the tolerance of 0.001, it meets the convergence requirement.

2. Plot velocity vectors on planes cut through the solution domain. Figure 10 shows the velocity vector on two planes through the center of jet.

   Note Over much of the outflow boundary, the velocity vectors are pointed into the domain. This indicates that the outflow boundary is not located far enough away from the jets. The results from this model cannot be trusted. A better model would extend the plenum zone in both the x and y directions.

   The presence of inflow at the outflow boundary is also indicated by the warning message in the .info file. Here is an excerpt from iteration number 411 in jetImpingement.info:

   \begin{verbatim}
   ITERATION NUMBER = 411
   -----------------------
   *** WARNING #001 *** FLUID INFLOW DETECTED AT SOME OUTFLOW BOUNDARIES
   WHERE MASS FLUXES ARE FORCED TO ZERO.
   IF THIS CONDITION PERSISTS, YOUR RESULTS MIGHT BE WRONG
   THE OUTFLOW BOUNDARY MIGHT NOT BE WELL SPECIFIED OR THE GRID MIGHT
   BE TOO COARSE NEAR THE OUTFLOW BOUNDARY
   \end{verbatim}

3. Plot contours of the pressure. Figure 11 shows the static pressure on the x-z plane through the center of jet. Note the large pressure drop through the nozzle, and the increase in pressure in the stagnation zone where the jet impinges on the heated surface.

4. Plot contours of turbulence kinetic energy. Figure 12 shows the turbulence kinetic energy on the x-z plane through the center of jet. Note the high turbulence levels downstream of the jet exit. There are two local maxima on either side of the jet core. These maxima are caused by the high shear rates on either side of the jet.

References


REFERENCES

Figure 9: Residual history for 411 iterations.

Figure 10: Velocity vectors on planes through the jet centerline. The $y$-$z$ plane is on the right, and the $x$-$z$ plane on the right. The plot legend is not shown so that both velocity vector plots can fit on the page.
Figure 11: Static pressure on a plane through the jet centerline.

Figure 12: Turbulence kinetic energy on a plane through the jet centerline.